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��4�;4����
�0)
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�"�
,0��0�5
� Nokia N70 )
�&���	;�B>�"/��	��!*����5 Camster 

+��������*���6"0 ������5��!�)���&
�
�0��* Camster "0����	
�>������	����������	;���(��"0�� Nokia N70 �	0��.����'�
�������	����"
� 

���	�	!�� Camster �"�
?�  +����4�� .(�!��� > Camster ��4�� 
New Game ������/���� +��)
����*��*��0� Camster �"!���0��� 
��4���	���� 
�0��4���B�)	�*�5��4����*(�� Camster ���+	���5)
�
)
�&���	;��*(�� Camster �"���	;���(��"0�� Nokia N70 
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?� '5' ��4��;���(��"0�� Nokia N70 (��	"�	�*�����	;���(�� 
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�0 Camster �)�4������6���
� Pet ��4��"/+� Camster +&����	����5)
�����5���
;��� 

+���9�
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�
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)
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�
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)
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)
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Wow! VideoTone 

Wow! VideoTone ������(���!"������)
���4����4��)
���A"
+����!�),��� ���)
���4�� �Exit� +����!�),������9�5��
��/�
��*4��5���5 +���	!������(���!"�����4����&���	�����0�+���0�)��� 
SMS Wow! VideoTone ��;/���A"
,0�"�)���	!���0� ����0�5��	�A" 
Wow! VideoTone 
�06���� �Options� +����4�� �Turn off Wow! 

VideoTone�

)
�&���	;�9���"(���!"���&9��	�*+�������
��	��+�����6"0 
����0�5��	�9���"(���!"��������������4����&���	�����0� 
�0��4�� 
�Set Call video� +���"�
?���4�� ��4���6����63������0�5��	+��
�"�
?���4���	4� �Options > Apply� ��4���4������	��4�� ��������� 
)
���5&���	;"/�������5(���!"���6"0�"��" �Options > Preview�
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�0��4�� 
�Set SMS video� +���"�
?���4����4����4��63���!"���
����0�5��	���5���� 
�0��4�� �Set Timer� +���"�
?���4�� 

�0
,0�
?���4��� 4 �!���5�	4��
?��������
���	���5���� +���" OK 

��4����4��63���!"���
��4����	���5)����4��:

� ��A"�	4��A" Wow! VideoTone &9��	�*��		�*�0�)��� SMS

� ��A"�	4��A" �Anykey answer�

Wow! VideoTone ��6������(���!"�����4����&���	�����0�
��	�����
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SettingWizard 

SettingWizard �����5)����	�������5)
�&9��	�*��	���5)��
��5./0
�0*	!��	 (MMS, GPRS +���!����	���8�), ������, Push to Talk 

(*	!��	�&	!����	�**�)	4�����) +����	+*�5�=��!"��� (*	!��	�&	!�
���	�**�)	4�����) ����0��/���5./0
�0*	!��		�**��5)
�

��������: 
���	
,0*	!��	�������� )
��0�5�!"�����*
./0
�0*	!��		�**�	4�./0
�0*	!��	��4����A"
,05����	�,4������
�0��/��	4�*	!��	�4��<

�"�
?�  +����4�� �
��+	���	 > SettingWizard

��4��	����	������/���)
��0�5��	���5)����	�������5)
� 
+���"�
?� 

������
1 ��4��)
���4���9���"��	���5)����������5)
� SettingWizard 

���	��&�*./0
�0*	!��		�**���
,06"0 ��4���6����./0
�0*	!��		�** 
��5)
� +����4�� ����

2 ��4��./0
�0*	!��	��������5)
����	����	

3 ��4���2!	�3���	���������� 
,0�2!	�3���	����	�**�9���"6�0 
���)
�6��+��
�

4 SettingWizard ����
�0)
��>��	��������"��5������+�"�"	& 
,4��./0
,0 +��	��&.��� ��4��+����	����	����9�"�* +�0���4�� 
������	� > �)��+�! �>��	��������" +�0���4�� ����

5 ��4�� ������	� > ���� ��4��)
��>���0��/��&	8�
6 ��4�� ���� ��4���4�������)
��0�5��	���5)������*��2�&9��	�*

./0
�0*	!��	���	�*

7 ��4�� ����

Push to talk 

1 ��4��)
���4���9���"��	���5)�� Push to talk (PTT) (*	!��	�&	!�
���	�**�)	4�����), SettingWizard ���	��&�*./0
�0*	!��	
	�**���
,06"0 ��4���6����./0
�0*	!��		�**��5)
� +����4�� ����

2 &9��	�*./0
�0*	!��	*�5	������0�5	�*
,4��./0
,0 	��&.��� 
+��,4������ ��4��+����	����	����9�"�* +�0���4�� ������	� > 

�)��+�! �>��	��������" +�0���4�� ����
3 ��4�� ������	� > ���� ��4��)
��>���0��/��&	8�
4 ��4�� ���� ��4���4�������)
��0�5��	���5)�� PTT &9��	�*

./0
�0*	!��	���	�*
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2 ./0
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,0 +��	��&.��� ��4��+����	����	����9�"�* 
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3 ��4�� ������	� > ���� ��4��)
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4 ��4�� ���� ��4���4�������)
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� &9��	�*
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�
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www.nokia.co.th/support/phones/n70
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Mobile search

Mobile Search 

)
�&���	;
,0 Mobile Search ��4��,���
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�
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��4�� ���
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�
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Lifeblog  

Nokia Lifeblog ����2�3��+�	�&9��	�*��2�+����	������4�;4� 
27�5
,0��8*�0��/�����!���"�����5< ���)
�	�*	��6�0
���	������4�;4�
��5)
� Lifeblog ����"��	(��;��� (���!"��� �0�)���+**������-	 
�0�)�������!���"�� +�� Blog post �"���������!����9�"�*����
���)
�&���	;�*	�&� )0��� +*�5�=� �.�+�	� +��&9�	�5�0��/�6"0 
)
�&���	;&�5�	4�+&"5�0��/���5)
�
�0./0�4����8�6"0�"�
,0 
Nokia Lifeblog PC +�� Nokia Lifeblog mobile

Nokia Lifeblog mobile ���	��&�*�0��/�����!���"����5)
�
�"���������! )
�&���	;
,0 Lifeblog 
���	�������5)
���4���*	�&�
	����	���5< &�56�
�0./0�4�� �	4��.�+�	���5��8*62�� 
�0�,4������
��	�������*��2���5)
��"�
,0&���)�*!� USB ���	�5	�*��	
,05��
	������ �	4� Bluetooth ��4��;������+��2!5�)	6�2�	����	

���	�������*��2���5)
�
Nokia Lifeblog PC 
�0)���&�"��5���"��
���	�*	�&�+��)0���
	����	���)
���8*	�*	��6�0
���	�������5)
� ����5�"�
?��"���
��4��;�������0��/�"0��&���)�*!� USB ���	�5	�*��	
,05��	������ 
�	4� Bluetooth (��;����	���*
���5)
� 	�����5(���!"��� 
�0�)��� +���0�)�������!���"�� ��6"0	�*��	;���������*6����
��	�������5)
�

����0�5��	)������"(�� )
�&���	;��8*&9�	�5G���0��/� 
Lifeblog ��5)
��"�
,0C�	�""!&�� +.�� CD, DVD 6"	3H+**
;�"���6"0 �	4�6"	3H
��)	4����� ��������� )
�&���	;��&��
	����	���5< 6�0
���8*�8�� (*�8��) ��5)
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���"# Lifeblog -�/��1�	����#$�2 

���	�!"���5 Lifeblog 
���	�������5)
� 
�0�9�"�5���
1 �"�
?�  +����4�� .(�!��� > Lifeblog

2 ��4�� &/( ��4���	!����	+�	���	�!"���5
3 ��4�� ���� ��4���!"���5+����!�),��� Lifeblog &9��	�*��	����� 

Lifeblog ��;/��!"���5
�+3>��0��/� .(�!���
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���"# Lifeblog �(�-�	�3���#$�2 
������	�!"���5 Lifeblog 6�0
���2���5)
� ��2���5)
��0�5��&!�5��������
� ��	�2&�2�	� Intel® Pentium® 1 GHz �	4�����*���� 

�	0�� RAM 128 MB

� �4��������5
�C�	�""!&�� 400 MB (	�����5�0�5�!"���5 Microsoft® 

DirectX® +��,
"��	+�	� Nokia PC Suite "0��) 
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� )���&���	;"0����	+&"5.��	�3A�)���������" 1024x768 

+��&� 24 *!�
� ��	�"��	+&"5.��	�3A� 16 MB

� Microsoft® Windows® 2000 (�2�	��!&+�8) 4 �	4�&/5����) 

�	4� Windows XP (Home +�� Professional, �2�	��!&+�8) 1a 

�	4�&/5����)
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2 �!"���5,
"��	+�	� Nokia PC Suite (	�����56"	���	�&���)�*!� 

USB CA-53 "0��)

3 �!"���5 Nokia Lifeblog PC

4 �����56��6"0�!"���5 Microsoft® DirectX® 9.0 �5
��)	4��5��2�
��5)
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�0"9���!���	�!"���5
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,0+����!�),��� Lifeblog PC


���	�,4��������	�������0���*��2����
,05��	������6"0�"�
,0��)������
6	0&�� Bluetooth 
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�0��!���5
� Favourites ���������
	����	6�����)	4��5��2� 	����	���,4��,�*+���0�)���+**������-	
����5)5��/�
���	������&�� ���)
�6��6"0	�*
��������5�4��
��������� © 2006 Nokia �	
����������
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��4���0�5��	+*�5�=�	����	 Lifeblog ��5)
� 
�0&�5	����	"�5�����
6���5��8*�8��
��!����	���8� ��4��
�0*
))��4����0�,�6"0
���"�*+	� )
��0�5&	0�5+�)�)������*	!��	��8*�8�����5+��
��7�5;75&�5	����	�7��6� 27�5)
���
,0����������5
���	��&��
��5)
� +����!��+�)�)�����8*�8��6�0
� Lifeblog 
���������*	!��	
��8*�8�����+���9�6�0&9��	�* Lifeblog )4� ��8*62�� www.typepad.com 

��5 Six Apart 


���	�������5)
� 
�0��!��+�)�)�����5��8*�8���5
� Lifeblog 


���	���5)����8*�8�� 
��)	4��5��2���5)
� 
�0+�06�+�)�)���

���0����5 Edit weblog accounts


���	��&��	����	�5
���8*�����	�������5)
� 
�0�9�"�5���
1 
� Timeline �	4� Favourites ��4��	����	����0�5��	��&��

�5��8*
2 ��4�� ������	� > Post to Web

3 ���)
�
,0)
�&�*��!�������)	��5+	� Lifeblog ���	���"/	����	
��8*�8������2!	�3���	���8*�8��

4 6"���8����	��&����8*�8�����	��@�7�� ��4����8*�8�����
)
��0�5��	
,0���	����	 Post to: ���)
�&	0�5��8*�8��
��� 
)
�&���	;����"�	����	��8*�8���"���	��4�� ������	� > 

Refresh weblog list 

5 �>��,4��+��)9��'!*���	���*&9��	�*��	��&�� )
���5&���	;
������	4��5	���	4�	��������"�������7��
�3A�"��0�)�����4����

6 ��4���	��*	0��+�0� 
�0��4�� ������	� > Send


���	��&��	����	�5
���8*�����2���5)
� 
�0�9�"�5���
1 
�6���6����	4�	����	���,4��,�* 
�0��4��	����	
"< ���)
�

�0�5��	��&��*���8* (&/5&
" 50 	����	)

2 ��4�� File > Post to Web... �	4�)�!��
?� Post to the Web 

��0����5 Post to Web ����A"�7��
3 �>��,4��+��)9��'!*���	���*&9��	�*��	��&�� 

)
���5&���	;������	4��5	���	4�	��������"�������7��
�3A�"�
�0�)�����4����

4 ��4����8*�8�����)
��0�5��	
,0���	����	 Post to:

5 ��4���	��*	0��+�0� 
�0)�!��
?� Send

�
��������4
����
5�����
�
�, &0!� CD 
���� DVD
������4������	�!���	��(�� .jpg ��5��	������4�;4�
�!"��0�5��5)
�+�0� )
���5�!���	��(�� .jpg +���!"���)�!� .3gp 

+�� .mp4 ���&4���4��< (�,�� +.�� CD �	4��3��"�	�
�C�	�""!&��
��5)
�) 6�6�0
� Lifeblog 6"0�,���"������

���	�!���	��(���	4��!"��������2����	�5	�*��	
,05��	������
6���5 Lifeblog &9��	�*��2� 
�0�9�"�5���
1 
�6���6����	4�	����	���,4��,�* 
�0��4�� File > Import from 

PC... ��0����5 Import images or videos from your PC 

����A"�7��
��������� © 2006 Nokia �	
���������� 26
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2 �*	�&�
�	����	��4��)0���63��(���	4��!"������	����	 
�	4���4���6�����3��"�	��4��< ��4��)0���63�����)
��0�5��	
�!���	�� 
,0	����	 Look in ��4���*	�&�6����6"	3H�	4�
�
��	���4��<

3 ��4��+3>��0��/� 63�� �	4�63������< 63�� )
�&���	;
"/�0��/���563��
���0����5 Preview: 6"0

4 )�!���� Import ��4���!���	��+3>��0��/� (	��;75+3>��0��/�����) 

�	4�63�������4��


���'����-���������������&�*��4
��
���������''��$����#	�3�
��4��)
��	!���0� Lifeblog 
���2���5)
� )
�&���	;��4���6���5
�9�+���5���5< 
�6���6���+��	����	���,4��,�*6"0���������!'� 
�!'����	�"�	8����&
")4���	
,0&�:���-�������4�����4����4���6��0�5��0�
�	4��0�����*����5	�"�	8��	4�����5,0�< �	4�)
����)�!����+;*����
��4����4�������� 
,0)
�&�*��! Go to date... �	4�
,0�
?��/��	

�������	
����
�
��	""/�0��/���!����!���������**	!��	��8*�8��+����	
,05��	�����* 
Lifeblog 6"0��� www.nokia.com/lifeblog �	4��"�
?� F1 
�+����!�),��� 
Lifeblog &9��	�*��2���4����A"�!'�
,0��5 Lifeblog

)
�&���	;��	�*	��&��	��
:��
,05��&9��	�*��0���5��	����� 
Nokia 2�	��&� N ���5��"6"03	� ��� www.nokia.com/nseries/lifeblog


"68������ PC Suite 

Nokia PC Suite )4�,
"+����!�),�����5�)	4��5)���!����	�
�����1���7��&9��	�*
,0	�����* Nokia N70


���	�!"���5+��
,05��,
"��	+�	� Nokia PC Suite )
��0�5

,0�)	4��5)���!����	����	�� Microsoft® Windows® 2000 �	4� XP 

+��
,0	�����*&���)�*!� USB �	4�����	�,4������ Bluethooth

����
,0,
"��	+�	� Nokia PC Suite )
��0�5�!"���5,
"��	+�	�

��)	4��5��2���5)
����� ��	""/�0��/���!����!�
�+.��2�"�	��
)/��4�./0
,0#*�*&�*/	����5,
"��	+�	� Nokia PC Suite ����/�
�	/�+**
�!��8��	��!�&�
�+.��2�"�	��

�������!�/��1�	����#$�2����
�'	�3�
�!2�	�"�	!����	�,4������,���
�0)
�&���	;�,4��������	�����
��5)
���0���*�)	4��5)���!����	����
,05��	������6"0 ��4��)
�
"9���!���	����������
��!2�	�")	*;0���
�������� ��	�����
��5)
����,4��������*�)	4��5)���!����	� +��)
�&���	;
�	!��
,0,
"��	+�	� Nokia PC Suite ����0�5����	�,4��������*
�)	4��5)���!����	�6"0
1 �!"���5,
"��	+�	� Nokia PC Suite �!2�	�"�	!����	�,4������

����A"�7���"���������!
2 ��4���	��(���	�,4�����������
,0��4���,4��������	�������0���*

�)	4��5)���!����	�
��������� © 2006 Nokia �	
����������
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3 �9����)9�+���9�����	��@*���0�����4���,4��������	�����
��*�)	4��5)���!����	�

��4���0�5��	
�0��A"�!2�	�"�	!����	�,4������
�(�����5 (�,�� ��4�����5)��
�	��(���	�,4�������4��) 
�0��4�� Get Connected 
�,
"��	+�	� 
Nokia PC Suite


��3
#/$���3�
Nokia PC Sync ,���
�0)
�&���	;2!5�)	6�2�	��,4��./0�!"��� �@!�!� 
&!�5����0�5�9� +��*���7�	�����5��	�������5)
�+�� PC Personal 

Information Manager (PIM) ���
,05��	������6"0 ��4��
�0�0��/�
���5
���	�����+����2����&�����/��&��
1 �	!��
,0,
"��	+�	� Nokia PC Suite

2 �,4��������	�������5)
���*)���!����	�"0��&���)�*!� USB 

���	�5	�*��	
,05��	������ �	4�
,0��	�,4������ Bluetooth

3 ��4�� Synchronise 
�,
"��	+�	� Nokia PC Suite

��������: ��4��)
��,4������)	��5+	� �!2�	�"��,���)
�
���5)�����"���	�**���56�0��5��	2!5�)	6�2�

�
������: )
�&���	;���5)����	�����+����2���5)
�

�02!5�)	6�2��0��/��"���������!��4���,4��������	�������*��2� 
+��,
"��	+�	� Nokia PC Suite �9���5�9�5����/�


�������#&�*���4
$��������
&9�	�5�0��/������	�������5)
��	4��	���)4��0��/����*���7�6�0���
)���!����	����
,05��	������6"0���*6������	�����
1 �	!��
,0,
"��	+�	� Nokia PC Suite

2 �,4��������	�������5)
���*)���!����	�"0��&���)�*!� USB 

���	�5	�*��	
,05��	������ �	4�
,0��	�,4������ Bluetooth

3 ��4�� Back up and restore 
�,
"��	+�	� Nokia PC Suite

4 
���� Select a task 
�0��4�� Make a backup... �	4� Restore 

backup...

5 �9����)9�+���9�*���0���
�
������: )
�)�	&9�	�5�0��/�
���	�������5)
�
����5&��9��&����4��,������������5��	&/:�����5�0��/�
��������!"�7��6"0


������
%'6�	&�*����(
��/�
)
�&���	;
,0 Image Store ��4����"��8*(��+���!"��������	�����
��5)
�6�6�0
��)	4��5)���!����	����
,05��	������6"0 +����!�),������
���	��&�*�����)����9���5��	�����+����	�"�����)����9�
��4��"/�����(��+��63���!"���
������;���6�0���5�����	��"��8*
)	��5���&
"�	4�6�� +������� +����!�),�������"��8*(��+��63��
"�5�����6�0
��)	4��5)���!����	�
��������� © 2006 Nokia �	
���������� 28
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��	)
0�)	�5"0���!�&!�'!E����0���!
�0�9���	)�"��� ��	+�06� 
��	��� �	4���	&�5���(�� ���5 (	��;75�&��5�	�����0�) +����4����
*�5&���6"0
1 �	!��
,0,
"��	+�	� Nokia PC Suite

2 �,4��������	�������5)
���*)���!����	�"0��&���)�*!� USB 

���	�5	�*��	
,05��	������ �	4�
,0��	�,4������ Bluetooth

3 ��4�� Store images 
�,
"��	+�	� Nokia PC Suite

4 ��4��)
�
,0 Image Store ����)	��5+	� �!2�	�"��	���5)������A"�7�� 
)
��0�5"9���!���	���5)��
�0�&	8�&!������ )
��75����"��8*
63�������	�������5)
�6�6�0
��)	4��5)���!����	�6"0 
��	"�9����)9�+���9�*���0���

5 ��4�� Store Now 
���0���������5 Image Store Image Store 

��)0���
������)����9���5�)	4��5+��
���	�"�����)����9� 
��4��"/�����(��+��63���!"������;������5�����	��"��8*)	��5���&
"
�	4�6�� (���	4��!"���
������5��"��;/���"��8*
��)	4��5
)���!����	� ���5��� �7����*�	��(�63�������4��
���	���5)��"0��


���!#������&�*6�	
"0�� Nokia Phone Browser )
�&���	;��"��	�0��/���5+3>��0��/�

���	�������5)
�.��� Windows Explorer 6"0 &�5�0��/�+��(��
�����	�����6���5��	����� �	4���	�����6���5)���!����	�
���
,05��	������6"0
��	)
0�)	�5"0���!�&!�'!E����0���!
�0�9���	)�"��� ��	+�06� 
��	��� �	4���	&�5���(�� ���5 (	��;75�&��5�	�����0�) +����4����
*�5&���6"0

1 �	!��
,0,
"��	+�	� Nokia PC Suite

2 �,4��������	�������5)
���*)���!����	�"0��&���)�*!� USB 

���	�5	�*��	
,05��	������ �	4�
,0��	�,4������ Bluetooth

3 ��4�� Files Manager 
�,
"��	+�	� Nokia PC Suite

4 
� Windows Explorer 
�0��4�� My Computer > Nokia Phone 

Browser > Nokia N70

5 ��4��+3>��0��/�����
���	��������)
��0�5��	"/
�
������: 
���		��3	,��0���+&"5�0��/�
���	����� 

�0��4�� View > Refresh


���!#�	�#
"0�� Nokia Audio Manager )
�&���	;&	0�5+����"��	63�����5
"!�!���*���2����
,0	������6"0 +��&�563��"�5�����6���5��	�����
���
,0	������6"0 �	4������	�����6���5��	����� 
��	)
0�)	�5"0���!�&!�'!E����0���!
�0�9���	)�"��� ��	+�06� 
��	��� �	4���	&�5���(�� ���5 (	��;75�&��5�	�����0�) +����4����
*�5&���6"0
1 �	!��
,0,
"��	+�	� Nokia PC Suite

2 �,4��������	�������5)
���*)���!����	�"0��&���)�*!� USB 

���	�5	�*��	
,05��	������ �	4�
,0��	�,4������ Bluetooth

3 ��4�� Transfer Music 
�,
"��	+�	� Nokia PC Suite
��������� © 2006 Nokia �	
����������
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One Touch Access �����5)����	��0�
,0���"8��"���������!
���./0
�0*	!��		�**�	4�./0
�0*	!��	 (*	!��	�&	!����	�**
�)	4�����) )
�&���	;�,4�������)	4�����6"0����5	�"�	8��"�
,0
��	�������5)
��������"8�
��)	4����� UMTS �	4�
,0 GPRS 


��)	4����� GSM

�	��"/
�0+��
������	�,4�������0��/��9���5�9�5����/�*���	�����
��5)
� ��	"�!"������0��/���!����!����./0
�0*	!��	��	�������5)
�
���)
��0�5��	
,0���"8���)������6	0&�� Bluetooth ���	G�� 
)
��0�5�!"���56"	���	����"8� Bluetooth ���� )
��75��
,0 One Touch 

Access 6"0

����	���������������������� �
One Touch Access ���!2�	�"��	���5)�� 27�5,���
�0)
����5)��
��	�,4������6"0 �"��9����)9�+���9�*���0���

�������������!"��������� �
1 �	!��
,0,
"��	+�	� Nokia PC Suite

2 �,4��������	�������5)
���0���*)���!����	����
,0	������6"0
3 ��4�� Connect to the Internet 
�,
"��	+�	� Nokia PC Suite

4 One Touch Access ���,4��������*�!����	���8���4������
.���6��	���� 10 �!���� ��������� )
�&���	;��4�� Connect 

��4���	!���,4������6"0

�������	
����
�
��	""/�0��/���!����!� +��"�������"���	�,�����&
"��5,
"��	+�	� 
Nokia PC Suite ��� www.nokia.co.th/pcsuite

Adobe Photoshop Album 
Starter Edition 

Adobe® Photoshop® Album Starter Edition 3.0 ��,���)
�)0��� 
+�06� +��+*�5�=�(��;�����5)
�6"0����55���"���"�
,0��2�
���
,05��	������6"0 "0�� Adobe Photoshop Starter Edition ���	�,����� 
)
�&���	;
� 
,0+�8���4����"��	(��;�����5)
� ��4��
�0)0���(��6"05����7��
� 
,0��0����@!�!���4��"/(��;���"!�!������5��"
�����"���
� +�06��0�.!"���"����6���5(��
�)�!��"���
� +*�5�=�(��;���"0���!'���	���5< �,�� &�5.��������� �!������

���*0�� �	4�&�56������	������)�4������
��������: +����!�),��������
�*�5(�-���������


���
���"#
�!"���5+����!�),��� Adobe Photoshop Starter Edition 
�)���!����	�
��5)
����2�"�	��������	0����*��	����� Adobe Photoshop Starter 

Edition �0�5
,0��*	�**�@!*��!��	 Microsoft® Windows® 2000 �	4� 
��������� © 2006 Nokia �	
���������� 30
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XP, Nokia PC Suite 6.5 �	4�&/5���� ��4���,4������	�����5��	�����
��5)
�+���)	4��5)���!����	� +�� Apple® QuickTime® 6.5.1 

�	4�&/5���� ��4��"/+��+�06�63���!"���
,
"��	+�	� Nokia PC Suite ����/�
�+.��2�"�	�����
�0���	0���0*
��	����� ���	�**��5)
�6��6"0�!"���5 Apple® QuickTime® 6�0 

�0�!"���5��� www.apple.com/quicktime/download


�0�9����)9�+���9���	�!"���5*���0���

/��6�	)!�4&�*����(
��/���
/��1�	��
��4�#�$����#$��	
(�����
�!'���	&�5(��;��������	�������5)
�6���5 Adobe Photoshop 

Starter Edition ��&�5�!'�

���	���(��;���+��63���!"���6���5)���!����	����
,05��
	������6"0�"���������! 
�0�9�"�5���
1 �,4��������	�������5)
���*)���!����	����
,05��	������6"0 

�"�
,0&���)�*!� USB 
�)���!����	� 6"���8��*8��2� 
Adobe Photo Downloader ����A"�7�� +��(��;���	��;75
63���!"���
������;����7�����5�����	;������)	��5���&
"
��;/���4���"���������!

2 
���	�	!���0�;������ )�!� Get Photos 63�������4�����5��"
��;/��!���	��6���� Adobe Photoshop Starter Edition ���*���
"< 
���)
�&	0�5
�)��5(����5��	�������;/�;������6���5 Adobe 

Photoshop Starter Edition +���9���"����+�8��"���������!

3 )
�&���	;��4���*63����������	�������5)
�6"0��4��
63�����������;/����6���5 Adobe Photoshop Starter Edition +�0�
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